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News and Announcements 

• lmageWrlter LQ Rework Program 
If you purchased an Apple Image Writer LQ between 
August 1987 and March 7, 1989, you may be interested in 
a recent Apple announcement: Apple may exchange your 
LQ for a reworked LQ. 

Apple has made the ImageWriter LQ quieter and elimi
nated the line squishing that some owners have encoun
tered on the top and bottom 1.5-inch of the page. The 
sound improvement lowers the frequency of the sound by 
about 500Hz (which is significant when printing dense 
graphics). In other words, the noise will not be quieter in 
certain applications, but the frequency of the noise will be 
reduced. The reworked ImageWriter LQ also comes with 
a HyperCard stack that guides the user through setting up 
the printer for various paper paths. 

This Image Writer LQ rework program is appropriate for 
customers who experience the following two problems 
when using continuous tractor-fed paper on their 
Image Writer LQ printers: line registration problems at the 
top and bottom 1.5-inch of the page and printer noise. 

There is no charge for this reworked printer, and it comes 
with a 90 day warranty. (Note that "reworked" means the 
printer is not necessarily brand new. Instead, it means the 
printer has had the appropriate engineering changes made 
to it.) 

Where Do You Go for the Exchange? 
The exchange (rework) program is handled through 
ACSS's Engineering Services group. The customer brings 
the printer to Engineering Services and gets a reworked 
printer in exchange. 

If you think you are a candidate for a reworked 
Image Writer LQ, contact Engineering Services at 625-
1595. If your LQ qualifies for the rework program (its 
serial number is less than 183101013), you can expect 
about a 2 to 4 day wait before you get the reworked 
printer. 
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Claris' Mac Write II 
for the Macintosh 

Many of the oldtimers on the Macin
tosh scene remember MacWrite as the 
Mac's first word processing package. 

Mac'W'r;teo® 11 MacWrite gradually fell out of favor as 
more advanced packages came to 

market. One reason for MacWrite's fall from grace was 
Apple's reluctance to upgrade and improve the package. 
This sluggish development stemmed from the fact that 
Apple needs the enthusiastic cooperation of third party 
software developers to make the Macintosh successful. 
Since third party software developers were reluctant to 
compete directly with Apple software, Apple decided to 
stop enhancement of the MacWrite package. Eventually 
Apple spun off a new company ( Claris) to handle develop
ment of the original Apple applications (including, Mac
Paint, MacWrite, MacDraw, and others). Because Claris is 
strictly a software company, they must sell state-of-the-art 
software to survive. While Claris recently discontinued the 
original version of MacWrite, they also released a completely 
new word processing program (MacWrite II). In this 
review we will look at Mac Write II release l.Ov l. 

Overview 
As you might expect, MacWrite II has all the usual Macin
tosh word processing features, including search and 
replace, cut, paste, undo, and use of the Clipboard to insert 
text and graphics. MacWrite II documents can include 
pictures and text, a variety of fonts and point sizes, headers, 
footers, columnar formatting, on-screen display of page 
breaks, automatic page numbering, special style sheets, 
stationery formats, and footnotes or endnotes. 

The philosophy behind MacWrite is "what you see on the 
screen is what is printed." In fact, on the screen your 
document appears as if it is a piece of paper. While you 
edit, you can see the top and bottom margins of your page 
on the screen; and you can see a grey strip separating the 
bottom of one piece of "paper" from the top of the next 
piece of"paper." This treatment is similar in spirit to how 
WriteNow displays pages on the screen. However, 
MacWrite II goes further and also allows you to display 
pages side-by-side on the screen. This display feature is 
useful if you have right- and left-handed pages (such as in a 
book where the page numbers appear on different parts of 
the page for alternate pages). This side-by-side feature is 
especially useful if you have a large monitor. If you have a 
traditional-sized monitor, you can still view two pages side
by-side, but the pages are reduced to fit on your screen. 
This reduction makes most type appear rather small, but if 
you have a steady hand on the mouse, you can still edit 
your text in the reduced size view. This contrasts with the 
current version of Microsoft Word (version 3.02) which 

allows you to preview full pages on the screen in reduced 
size, but does not allow you to edit your text in this view. 

Editing Documents 
With MacWrite II you can work on more than one docu
ment at a time; each document appears in a separate 
window. MacWrite II can open most popular Mac word 
processing programs' documents directly, including 
WriteNow, Microsoft's Word, Write, and Works, as well as 
old MacWrite documents. If you want to incorporate an 
existing document or a picture into the MacWrite II 
document you are editing, you can use the Insert File 
feature and incorporate the existing file into your docu
ment (including MacPaint and PICT files) without resort
ing to the Clipboard or Scrapbook. We would like to see 
this step-saving feature in more word processing software. 

While MacWrite II's Size menu lists font sizes from 7 point 
to 72 point, you can select any size of font from 2 to 500 
point; although at 500 point we usually could fit only one 
character on a page. You use the Size menu's option 
named Other to specify font sizes not listed in the menu. 

With Mac Write II you can search for and replace text based 
on a variety of criteria. You can search and replace based 
on the text alone or based on the text and the text's type
face attributes (font, size, and style). For example, you 
may wish to change all occurrences of Whole Earth Catalog 
that are bold text and change the style to italic. This is 
easily accomplished with the Use Attributes feature in 
MacWrite II's search and replace function. 

MacWrite II gives you a great deal of control over docu
ment formatting. As with most Mac word processing 
software, you use a ruler to specify tab stops, margins, line 
spacing, and the like. If you want to format your docu
ment so that it looks like a newsletter (i.e., multiple 
columns of text), you specify the number of columns you 
want in the Format menu's Page dialog box. After you 
have told MacWrite you want several columns, your text is 
displayed (as it will print) in side-by-side columns. You can 
edit these columns on the screen. This contrasts with the 
current version ofWord; while Word can print multiple 
columns of text, you cannot see and edit the page on the 
screen exactly as it will print. 

If you want a header or a footer to appear on each page of 
your document, select Insert Header (or Insert Footer) 
from the Format menu. A blank header is then placed at 
the top of each page in your document. You can enter any 
text that you want to appear in the header. We found this 
scheme to be delightfully intuitive since the header appears 
where you expect it to, rather than in a separate window 
(as is the case with Word). To change something in the 
header, use the mouse to point and click on the header 
text. At all times you can see the effect of the header (or 
footer) on your page's format. This is another illustration 
of MacWrite II's intuitive user interface. One of our 
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biggest complaints about Word has been that it is loaded 
with special modes and hidden features whose effects are 
not clear until you actually print your document. (In 
Word, you edit headers and footers in windows that are 
separate from your main document window. Headers and 
footers aren't displayed until you print the document or 
ask for a preview of the printed document.) 

Footnotes and Endnotes 
MacWrite II has an automatic footnotes feature (i.e., 
footnotes are automatically numbered as you create and 
edit them). You can place the footnotes at the bottom of 
the page or column in which the reference appears, or at 
the end of the document as endnotes. Again, since you see 
the page as it will print, you see the footnotes at the 
bottom of your page or column; and on a Mac Write II 
page, you can edit everything you can see. 

We found that if you have very long footnotes, it may be 
necessary for MacWrite II to leave extra blank space on one 
page to have the footnote on the same page as its refer
ence. As you modify the footnote itself, MacWrite II 
handles the reformatting. 

Spelling Checker and Thesaurus 
The spelling checker uses a 100,000 word dictionary, and 
it automatically provides suggestions for words it does not 
find in the dictionary. MacWrite II searches the entire 
document for all occurrences of each questionable word. 
As shown in Figure l, the Spelling dialog box provides a 
word count and several suggestions for replacement as well 
as options for entering your own correction and a Learn 
button you can use to add the word to the dictionary. In 
our example, Mac Write II's # l choice for our misspelled 
sperate was spirit. To edit sperate ourselves we began by 
clicking in the text box and adding an "e" between the "s" 
and "p." 

We were surprised to find that MacWrite II claimed we did 
not have enough memory to use the spelling checker when 
we first ran it under MultiFinder on a Mac with 2.5MB of 
RAM. However, the fix for this complaint is easy. If you 
plan to run the spelling checker and use MultiFinder, we 
suggest you set MacWrite II's memory size to at least 

Word: 

XI 
X2 
X3 
X4 
xs 
X6 

Figure 1: Spelling Checker 
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BOOK. You do this by returning to the desktop and 
selecting the MacWrite II icon; then choose Get Info from 
the File menu. Finally, type a new number in the Applica
tion Memory Size's text box. When you run Mac Write II 
under the Finder, this problem does not occur. 

The 220,000 word thesaurus (a Word Finder desk acces
sory) is quick and clean. When Word Finder is made 
active, WF is added to the menu bar. To find a synonym 
for a word, double-click on the word to highlight it, pull 
down the WF menu, and select Lookup. Word Finder 
locates all synonyms and antonyms of the word and 
displays them in a separate window. You may then select 
one of the alternate words to replace the highlighted word 
or simply return to the document with no change. 

Other Features 
You can use the Style menu's Custom option to create 
custom styles combining a font, size, and style, such as 
italic and bold; you can add up to 30 custom styles to the 
Style menu. This feature allows you to use a single com
mand to change all the style attributes of text you select or 
to begin typing with a custom style. MacWrite II auto
matically assigns Command-key equivalents to the first ten 
styles you create and displays them in the Style menu. 

MacWrite II's stationery files are another useful feature. 
Sometimes you may want to use the same format for 
certain types of documents, such as internal memos. You 
can create a Stationery file with the font, margins, and 
headers you want for internal memos. Thereafter, when
ever you open that stationery, you get a copy of the 
original format. MacWrite II provides you with stationery 
templates called Letter, Memo, Newsletter, and Resume. If 
you don't wish to use the default settings provided by 
MacWrite II, you can create your own Automatic Station
ery; Mac Write II will use this stationery every time you 
open a new document. (This stationery is simply a special 
MacWrite II stationery file that is put in the System folder.) 

With the Merge feature you can send form letters to people 
on a mailing list. To use this feature you create two files: a 
data document containing the information that is to be 
used for personalization and a form letter document 
indicating where to insert the names, addresses, and any 
other information. When you select the File menu's Merge 
option, MacWrite II automatically creates form letters. We 
found it significantly easier to set up documents for merge 
printing with MacWrite II than with Word. Since we've 
found that merge printing seems to mystify many Word 
users, this is a significant MacWrite II feature. 

MacWrite II's smart quotes feature automatically uses the 
appropriate quote marks when you hit either the single or 
double quote key. That is, your quotes automatically do 
'this' or "this" (not 'this' or "this"), so the leading quote is 
different from the trailing quote mark. 



Manuals and Online Help 
Claris offers a variety of support: a spiral-bound User1s 
Guide, a Getting Started booklet, online help, and a Qjlick 
Reference card. The online help has the appearance of a 
HyperCard stack and is well indexed and accessible; to use 
it, pull down the ti menu and select Help. After the first 
access, Help remains in a window behind the current 
document and is immediately available for subsequent 
requests. 

The Getting Started manual covers installation of 
MacWrite II on your system, how to start a new docu
ment, make revisions, add the finishing touches (spell 
checking, inserting graphics, saving, and printing the 
document), and the basics for creating form letters. 

The Qjlick Reference is an 8-page guide to using the 
commands, grouped by function (such Laying Out a 
Document). 

The User1s Guide is a well written and adequately indexed 
reference to all MacWrite II commands and functions. 
The manual includes both hints for using many of the 
commands effectively and suggestions for possible uses. 
MacWrite II's advanced features are usually explained in a 
concise, clear manner; the manual makes good use of 
graphics. 

Hardware Requirements 
MacWrite II runs on a Macintosh Plus, SE, SE/30, II, IIx, 
or IIcx, with two 800K disk drives (or one 800K disk drive 
and a hard disk), and System Software 6.0 (Finder 6.1 or 
MultiFinder 6.0) or higher; it requries at least 590K of 
RAM. 

Compatibility 
Not only can you import files from other software pro
grams (using the File menu's Open or Insert File com
mands), but you can also save MacWrite II files in different 
formats. To do this, use the File menu's Salle As command 
and click on the Mac Write II button as shown in Figure 2. 
When you do this and hold down the mouse's button, you 
get a pop-up menu that lets you save your file in the fol
lowing eight formats: MacWrite II; MacWrite II Station
ery; Text; MacWrite 5.0; WriteNow 1.0; and Microsoft 
Word 3.0, Works l.l, and Write 1.0. 

Upgrades and Trade Ins 
If you are a registered owner ofMacWrite 5.0, you can 
upgrade to MacWrite II for $20. To do this, bring your 
original Mac Write 5.0 disk to the Electronics Desk. (The 
Microcomputer HelpLine was able to distribute free 
upgrades to MacWrite owners only through version 4.6. 

All MacWrite 5.0 owners will have a version 5.0 master 
disk.) 

You may be able to get MacWrite II for $30 by trading in 
your current word Mac processing software. The trade-in 
program applies to WriteNow, WordPerfect, MindWrite, 
WordHandler, and Microsoft's Word, Write, and Works. 
If you want to participate in the trade in, bring your 
original disk to the Electronics Desk at the Book Center. 

Summary 
Mac Write II is competitive with the best of the current 
crop of Mac word processing software. Although 
Mac Write II does not have a few of the features that are 
available in the current version ofWord (such as the 
scientific equation capabilities, indexing, and table of 
contents generation), MacWrite II makes up for this by 
including features that are not available in Word (such as 
true "what you see is what you get" multiple column 
layouts, a much more intuitive user interface, smart quotes, 
and integrated headers and footers). 

Mac Write II has all the features that most people need in a 
word processing package. Yet, like its predecessor, 
MacWrite II is easy to learn and use. In addition, it can 
read and write other programs' files directly. If your 
Macintosh is capable of displaying color you can even edit 
in color with MacWrite II. (Now we just need cheap color 
laser printers and photocopiers.) 

You can buy MacWrite II from the Electronics Desk for 
$65. If you buy a Macintosh from the Book Center, you 
can choose MacWrite II as the word processing software to 
be bundled with your machine. 

Figure 2: Save As Options 
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OmniPage 
Text Recognition Software 

OmniPage from Caere Corporation is optical 
character recognition (OCR) software that can 
read the characters from a piece of paper using 
page scanner hardware. Once the characters 
are read, you can use them in a Macintosh or 

IBM-type microcomputer. On a Macintosh, OmniPage 
reads the characters directly into a text or MacWrite file. 
You can open the converted document with your favorite 
word processing package and edit it. OmniPage can also 
digitize photographs. This means you can feed the 
machine a picture of your dog, a picture from a magazine, 
or a photo from your electron microscope and store that 
image for later processing. 

There are versions of OmniPage for both the Macintosh 
and IBM and compatibles. Because we do not have the 
IBM version of OmniPage, we will talk only about the 
Macintosh version in our review. 

Hardware Requirements 
Macintosh: On a Macintosh, OmniPage requires a Mac II, 
IIx, IIcx, SE/30, or a Mac SE with a 68020 accelerator 
card. You also need at least a 20 megabyte hard disk and 4 
megabytes ofRAM. (If you have a Mac SE without an 
accelerator, you can send the original disk back to Caere, 
and they will exchange it for the Mac SE version. We 
suspect that the plain SE version will be very, very slow.) 

IBM and Compatibles: To run the IBM version ofOmni
Page, you need an IBM AT or compatible with 640K 
memory, a high capacity 1.2MB 5.25-inch floppy drive or 
a 720K 3.5-inch drive, and at least 8MB of hard disk space. 
Since OmniPage for DOS machines runs under Microsoft 
Windows version 2.0 or above, you also need that software 
and a mouse. OmniPage for the IBM comes with an 
OmniPage Co-Processor Board that will fill one full length 
slot in the AT. Since this board is not Microchannel 
compatible, it will not work in the IBM PS/2 Models 50, 
60, 70, or 80. 

You will also need a page scanner. The Mac version of 
OmniPage supports the Apple Scanner, Hewlett-Packard's 
Scan]et and Scan]et Plus, Dest Scanners, and Microtek 
Scanners. We tested Apple's scanner and briefly tested 
HP's new Scanjet Plus. OmniPage for the IBM supports: 
Hewlett-Packard Scan]et and Scan]et Plus, Microtek Series 
300, Dest Series 2000, and Cannon IX-12 or IX-l2F. 

Text Scanning 
Page scanners, such as the Apple or HP scanners, convert a 
printed page into a series of black and white dots. We call 
a collection of these dots a bit-map. Most OCR software 

compares the characters they read to a fixed pattern of 
character bit-maps. This means that they recognize only a 
few character sets, such as Courier and Elite, and are 
limited in the size of the characters they can read; normally 
they can read 10 or 12 point characters. OmniPage goes 
beyond this technology to compare the shapes of images 
(the pictures of the characters) to the shapes of various 
characters. For example, the shape it knows as the charac
ter "a" against the following shapes: 

aaaaaaaaa 
!2IJ.H:.aa.g,aag 
aaaaaaaaa 

This intelligent recognition lets OmniPage read many 
fonts, including proportionally spaced fonts. However, 
since you cannot train OmniPage to associate a shape with 
a particular character, you cannot improve OmniPage's 
ability to read a document. Don't expect OmniPage to 
read very stylized fonts, such as Venice or San Francisco. 

To read a document, you place the sheet of paper you wish 
to read in the scanner and tell OmniPage to scan text by 
choosing Scan Text. OmniPage first reads the whole docu
ment into your microcomputer's RAM. Then it takes a 
second pass through the document to recognize the 
characters. Finally, OmniPage stores its result in a text or a 
MacWrite file (a pre MacWrite II file). By storing the text 
in a MacWrite file, you can retain special effects such as 
boldface, underlining, and italicized characters. Since most 
word processing software for the Macintosh can read 
MacWrite files, it should be relatively easy for you to 
import these files into your favorite word processing 
software. 

If the document to be scanned has a mixture of text and 
pictures, OmniPage will ignore the graphics during its text 
recognition step. 

Columns 
OmniPage also attempts to keep the columns in a multiple 
column document in proper order. During the second 
pass it separates columns so you do not get the first line of 
the second column connected to the first line of the first 
column. For example, if OmniPage is confronted with this 
document: 

This has been a test of the 
American Broadcasting 
System. Had there 

been an actual 
emergency you would have 
been instructed to tune ... 

you would not want to get something like this: 

This has been a test of the been an actual 
American Broadcasting emergency you would have 
System. Had there been instructed to tune ... 



The column feature does not always work properly; some 
paragraphs can be inserted in the wrong place. If you scan 
columns, you should proofread the results of OmniPage's 
conversion carefully. 

Speed 
OmniPage's speed is directly linked to what it is reading. 
If the font and size are easy for OmniPage to read, the 
speed is very good; peak performance is 150 characters per 
second (CPS). The average speed is advertised to be about 
40 CPS. 

Limitations 
Even though this is a remarkable piece of software, it will 
not read every document you have. There are two main 
constraints to OmniPage's ability to read your document: 
the font and the size of the font. In fact our tests indicate 
there is an interaction between the two. 

The minimum font size that seems to be readable with any 
acceptable accuracy is 8 points. Here are five examples: 

Bookman 8 point 
Times 8 point 

Helvetica 8 point 
Narrow Helvetica 8 point 
Courier 8 point 

If the size falls below 8 points, errors become more 
frequent. We also found that as the size goes above 18 
points, errors will also occur more often. Here are five 
examples: 

Bookman 18 point 
Times 18 point 

Helvetica 18 point 
Narrow Helvetica 18 point 
Courier 18 point 

Since the body of most text is greater than 8 points and 
less than 18 points, these size limitations will generally not 
cause problems. However, you may find some footnotes a 
problem. Based on our tests with the fonts named above 
(Bookman, Times, Helvetica, Narrow Helvetica, and 
Courier), OmniPage seems to be optimized to read Times, 
Helvetica, and Courier; these fonts are very commonly 
used. Although other fonts are readable, errors are more 
common. 

There is a wide variety of styles for a given font. For 
example, we found over 20 different styles for Helvetica. 
These differences include changes in the width of the lines 
that form the character (bold, regular, and fine) and the 
italization of the font. In general, we found that fine 
characters are harder for OmniPage to read successfully. 

Replacement Character 
When OmniPage cannot recognize a character, it replaces 
that character with the- (called a tilde) character. (If you 
get tildes, you can use your word processing software's 
search command to find tildes and then replace them with 
the proper character.) We recommend that you run the 
scanned document through a spelling checker to help you 
find errors. OmniPage will often replace a letter e with a 
lettter c - especially if the font is small. 

Flawed Originals 
There are several cases in which OmniPage will fail to 
correctly read parts of a document, even if the font is 
readable. If there are some extraneous marks on the paper 
(e.g., a pencil mark, a dot of ink, or some imperfection in 
the paper), OmniPage can misread a character. In one of 
the documents we scanned there was a dot of ink (left by a 
copy machine) under a letter c. OmniPage interpreted that 
c as the letter g. OmniPage may also have trouble reading 
documents that were printed with a light (worn out) 
ribbon; a solution for this problem may be to photocopy 
the original and scan the copy (copy machines will often 
produce a copy that is darker than the original). 

Symbols 
OmniPage will read only American English characters; it 
cannot read the Greek symbols used in mathematical 
formulas. However, since OmniPage supports ASCII 
(American Standard Code for Information Interchange), it 
recognizes the following ASCII characters: 

• the letters Aa through Zz 
• the numbers 0123456789 
• common punctuation . , ; : ? ! -
• and these ASCII symbols 

( ) @ # $ % & * " I + = I \ <> [] {} 

These are the symbols that can be typed from most 
keyboards with or without the shift key. There are some 
common symbols it does not recognize: ' (grave), ",and_; 
and generally OmniPage interprets I as an uppercase I. If 
you have the following in your document: 

T otai_Price 
number" 

you will get 
you will get 

Graphics Digitizing 

Total Price 
number~ 

OmniPage's strong suit is not digitizing graphics; it has no 
control over the brightness and contrast (light, normal, 
and dark) settings. These controls are usually found in the 
better digitizing programs. In addition we found it 
difficult to isolate the part of the page we wanted to scan 
from the entire page because the screen preview of the scan 
is extremely dark. You must use the partial page and fine 
adjust options to find the portion of the page you wish to 
save. 



OmniPage can digitize a picture as a halftone or a line 
drawing. If you select drawing, OmniPage will usually 
ignore the white spaces between lines (even if there is a 
smudge). You use the halftone mode to scan pictures. 

You can save the image to disk in two different types of 
files: TIFF (Tag Image File Format) or uncompressed. 
Although TIFF files can also be used in other programs, 
such as Aldus PageMaker, they are unreadable by most 
Macintosh software. Both TIFF and un-compressed files 
can be reloaded into OmniPage for further processing. 
You can open a TIFF file that you have gotten from 
another source and have OmniPage do text recognition on 
any text in that TIFF file. However, be advised that TIFF 
files tend to be larger than will fit on a 800K diskette. You 
will need a hard disk to store images you save as TIFF files. 

Conclusion 
OmniPage version 1.0 for the Macintosh is the best 
microcomputer OCR package we have seen. OmniPage 
can read many fonts and sizes, including proportional 
fonts. Although its graphics scanning is limited, this 
package is worth considering for anyone who needs OCR 
capability. 

The Macintosh version ofOmniPage comes with a Hyper
Card based tutorial. This tutorial goes through Omni
Page's basic features; in order to run the tutorial you must 
already have HyperCard on your hard disk. Since Omni
Page requires over 3MB of RAM to run and HyperCard's 
suggested memory size is 1MB, it is impractical for most 
people to run HyperCard and OmniPage together. 

A drawback to OmniPage is that it requires a lot of com
puter resources. You really need a Mac II or above with at 
least four megabytes ofRAM and a hard disk. You also 
need a scanner. 

We tested OmniPage with the Apple Scanner and briefly 
with Hewlett-Packard's new ScanJet Plus. Both scanners 
performed very well. There was a slight difference in the 
results we achieved with the different scanners, but overall 
we cannot say that one is better than the other for recog
nizing characters. 

The list price for the Apple version ofOmniPage is $795. 
!he IBM versi~n is $2495; this IBM-compatible package 
mc!udes an 8-btt co-processor card (hardware) that is used 
to Improve performance. Educational institutions receive a 
25 percent discount on OmniPage. You can reach Caere 
Corporation at 100 Cooper Court, Los Gatos, CA 95030, 
(408) 395-7000. For additional information, you can also 
call 800-535-SCAN. 

Connections 
E-Malllng Mac Documents 

Suppose you use a Macintosh for your e 
word -processing and other research ·~~ 
needs. Your colleague is in Grenoble, 

France and she, too, has a Macintosh. You 
wish to send some Mac Write and Excel documents to your 
colleague. What is the most effective way to get the infor
mation to her? 

Assuming your colleague has the software applications nec
essary to read the documents you send, the easiest way is to 
send them through the post office. Macintosh disks are 
hardy and usually survive a trip through the mail without a 
problem. But, you say mail can be slow and you're anxious 
to get the documents to your colleague soon; you want to 
know about electronic-mail (E-mail) as an alternative form 
of delivery. Assuming your colleague has an electronic
mail address on some accessible network (e.g., Internet and 
BITNET are both accessible from the ACSS machines UX 
and VX), you could send her E-mail that she would receive 
within a few minutes or hours. However, to send your 
colleague the MacWrite document and Excel spreadsheet, 
you must go through intermediate steps. 

Encoding Rles for Transmission 
All computers store information as patterns of zeros and 
ones, that is, in a binary code. However, the Macintosh 
uses certain patterns, the VAX uses others, and the IBM 
PC yet another pattern altogether. In addition, the 
electronic mail you send may need to be handled by several 
cooperating, but dissimilar, computers enroute to its 
destination. Some bit-patterns that exist happily on a 
Macintosh could hopelessly confuse another type of 
computer. The best way to safely send information 
through a heterogeneous network of computers is to 
encode the file as bit-patterns that will not choke any 
computer. The safest form that mail should take is that of 
the bit-patterns that constitute plain text (also called 
standard ASCII printable text characters). 

Sender and Receiver Use BinHex 
You can use free (public-domain) software called BinHex 
4.0 to encode any Macintosh document as a plain text 
document (an ASCII file). Then you can send this ASCII 
document via E-mail. The recipient of the electronic-mail 
must also possess a copy ofBinHex and use it to reconsti
tute the original form of the Mac file. In this example 
they reconstitute the ASCII documents as Excel and ' 
MacWrite (or MacWrite compatible) documents. 

Sending a BinHex 4.0 File 
Let's ~lk through an example of how to do this using a 
MacWnte document we've called The Dordogne. Begin by 



double-clicking on the BinHex 4.0 icon. To locate the file 
you wish to encode, choose ApplicMion> Upload from the 
File menu. Then select the file (The Dordogne) and click 
on the Open button. Next you will be asked where to put 
the encoded (binhexed) file; Figure l shows you this step. 

Agure 1: Name BlnHex 4.0 Ale 
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It is customary to append the suffix .Hqx to a file name to 
indicate that it has been created by BinHex 4.0 (although 
you can name the file whatever 
you want). Once you've named 
the file, choose Q;t-it from the File 
menu. As you can see from 
Figure 2's BinHex 4.0 icon and 
file name, we asked that the 
results be put in a file with the 
customary BinHex suffix. 

Figure 2: 
BinHexed 4.0 File 

ThP DordognP .Hqx 

Our The Dordogne.Hqx file just contains text. If you are 
curious about this encoded text, you can open the text only 
file using your favorite word processing software. The text 
only file will look something like the abbreviated example 
in Figure 3 (the encoded file looks like garbage to most 
people). 

Once you have transformed the Mac document into a 
BinHex 4.0 file, you need to move the binhexed file to a 
machine that can E-mail the file to your colleague. There 

are at least two ways you can transfer this ASCII document 
to the computer you will use to send the electronic mail. 
You can use theftp (file transfer protocol) facility built into 
NCSA Telnet to transfer this encoded document, or you 
can use a modem and communications software to make 
the transfer. 

Exactly how you send the binhexed information to your 
colleague will depend on the computer and mailing pro
gram you use. 

Reconstituting a BlnHex 4.0 Rle 
When your colleague gets your mail, she must transfer the 
message to her Macintosh and remove all the text (mail 
headers, etc.) before the line shown below: 

(This file must be converted with BinHex 4.0) 

She can remove the text with any Mac word processing 
sdftware. 

Next choose Upload>Application from BinHex 4.0's File 
menu to convert the received message back to the original 
MacWrite or Excel document's format. The converted file 
will have whatever graphics and complex layout you 
originally sent. 

Rle Size Limitations 
The process could be that simple, but usually it isn't. The 
first complication you could run into is that your binhexed 
(encoded) text is much too large for electronic-mail 
programs to handle comfortably. 

Messages much larger than 30-40K may not make it past 
many mail processing programs; and even if they do, it is 
inconsiderate (bad "netiquette") to mail chunks larger than 
30-40K. 

You need to chop your encoded text into 30Ksize or 
smaller pieces. An easy way to do this is to open the 
oversize binhexed file with your favorite word processor, 
select a chunk of text, and cut it up (use the Edit menu's 

Figure 3: A Sample BinHex ASCII File 

(This file must be converted with BinHex 4.0) 
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[ ... etc. for many many lines .... all deleted in this example.] 
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Cut command to cut out and retain the text). Now you 
can create a new document and paste the chunk of cut text 
into it. Save this new document as text only; perhaps call it 
Part 2 so you can keep track of how the pieces will go back 
together. (You can usually find the text only option in the 
Save As menu.) Keep doing this to the original binhexed 
file until you have a series of smaller files. 

Now you can mail the parts, one by one. We suggest you 
give your messages subject lines, such as Dordogne part 1 of 
5. Since your mail could arrive out of sequence, the 
subject lines will help the recipient paste the pieces back 
together. 

Other Problems 
This may seem obvious, but we believe it bears mention
ing: make sure that your colleague has a suitable applica
tion to read what you send her. 

Finally, there is the question of fonts. If you have a 
MacWrite document formatted to use the Palatino and 
Symbol fonts, your recipient must also have Palatino and 
Symbol installed in her System. If she does not, her 
Macintosh will attempt to find the best possible match 
from among the fonts she does have. The results of this 
font substitution and/or scaling may look quite different 
from what you had intended. 

If she does not have the fonts that you used in your 
composition, you have a few choices. You could forewarn 
her that she needs to install the fonts in her System (with 
Apple's Font/DA Mover) before she can properly read or 
print what you send her. However, she may not have the 
requisite fonts at hand, especially if you use non-standard 
fonts. (Times, Helvetica, and Courier are the most 
common LaserWriter fonts; Geneva and Monaco are 
probably the most common ImageWriter fonts). If you 
know (or suspect) that your colleague does not have the 
Symbol and Palatino fonts that you used in your docu
ment, you could use Font/DA Mover to create a file 
containing these fonts and send that font file to her along 
with the other files. Of course, you must also encode 
("binhex") this font file. Before reading or printing your 
documents, your recipient must decode ("un-binhex") the 
font file. She also must use Font/DA Mover to install the 
fonts in her Macintosh System file. 

Font/DA Mover files look like the suitcase icon shown in 
Figure 4; the icon from the mover application is a truck. 

Figure 4: 
Font/DA Mover Icons 

w L1TI 
Font/DA Move-r Symbol Font 

Where Do I Get These Tools? 
If you have an account on a campus machine that can send 
mail to other campus machines, that machine probably also 
has the capability of sending mail to other parts of the 
country and the world. 

Getting a username on one of the ACSS machines might 
be the simplest way to go. To establish an account on an 
ACSS mainframe, contact ACSSAccountsat 625-1511. 

You can copy BinHex 4.0 from the Utilities folder on the 
information volume of the Mac Information Server. You 
can access the Mac Information Server from most of the 
public labs on campus and also from two Macs at the 
Microcomputer HelpLine in 125 Shepherd Labs. 

Font/DA Mover is part of the System software that came 
with your Mac; copies are also available from the informa
tion volume of the Mac Information Server. Look in the 
System Software folder for the version ofFont/DA Mover 
that goes with the version of System software you use. 

Ma Micro Notes 

• dBASE to Paradox File Transfer 

r In previous issues of this newsletter we have de
scribed various database programs for IBM-type 
computers, specifically Paradox, dBASE, and Profes
sional File. Such reviews are useful if you are buying 

a database program for the first time, but what if you are 
already using a program? You don't want to throw 
everything away and start over again just because a differ
ent program seems like it would suit your needs better. 
What about all the files you have already created? You 
certainly don't want to enter the data all over again. This 
is where file transfer enters the picture. 

Most vendors know that their database program doesn't 
exist in a vacuum. There are other databases in the market. 
The clever vendors acknowledge each other's presence and 
make it possible for users of other database programs to 
transfer their existing files into the new program. Some 
database packages make such file transfers easier than 
others. 

Paradox is a relational database program which we re
viewed in our November 1988 Microcomputer Newsletter. 
We have found Paradox to be more powerful, easier to use, 
and more reliable than dBASE III Plus and are in the 
process of converting our dBASE files into Paradox files. 

File transfer from dBASE into Paradox is simple. These are 
the steps: 



0 Run Paradox. 
0 Select Tools/Exportlmport/Import/DbRSe. 
0 Type in the name of the dBASE file. (The file can be a 

dBASE II, III, or III Plus file; Paradox will figure it 
out.) 

0 Type in the name you want for the equivalent Paradox 
file. 

0 Wait. (It took an IBM AT 90 seconds to convert a 
mailing list with 3758 records.) 

Since both Paradox and dBASE have strict rules about field 
length and type, Paradox simply uses the dBASE field 
name, length, and type. There are, however, a few conver
sions that take place, and one potential problem with lost 
data. 

0 Alphabetic and numeric fields transfer with no change. 
0 dBASE logical fields become Paradox character fields 

with a length ofl. "True" (.T.) and "false" (.F.) are 
converted to the characters T and F. 

0 Paradox does not have the equivalent of a memo field 
and will import only the first 255 characters of a 
dBASE memo field. The rest of the field will be lost. 

Paradox will also import l-2-3, Symphony, PFS, VisiCalc, 
and ASCII (plain text) files with similar ease. 

In conclusion, with the exception oflong memo fields, it is 
a trivial matter to import dBASE files into Paradox with no 
effort and no loss of data. 

e DOS CONFIG.SYS Flies 

r In the old days ofPC/MS-DOS, few people needed 
to create special configuration files called 
CONFIG.SYS. However, as software and hardware 
that work with IBM-type machines becomes more 

demanding and complex, this is no longer true. Today 
more people need to create configuration files or alter 
existing CONFIG.SYS files to get their software to run 
properly. Several articles in last month's issue of our 
newsletter mentioned commands that need to be inserted 
into a CONFIG.SYS file. 

Like the file called AUTOEXEC.BAT (a batch file that is 
automatically executed when you start up your computer), 
DOS gives the CONFIG.SYS file special treatment. When 
you start up your machine, DOS automatically checks your 
root directory for a file named CONFIG.SYS. If DOS finds 
this file, DOS will configure itself based on the commands 
stored in CONFIG.SYS. Your DOS manual lists all the 
commands you can insert in a CONFIG.SYS file. 

Since the CONFIG.SYS file is just an ASCII (plain text) 
file, you can create or edit it with most word processing 
software. However, to create an ASCII file you cannot 
save the document in the usual manner. Since the steps 

you need to go through to save the document as an ASCII 
file differ from one word processing package to another, 
we'll show you one way to create and alter a CONFIG.SYS 
file without using word processing software. 

The TYPE Command 
Your first step is to see whether or not your system already 
has a CONFIG.SYS file. If you have this configuration file, 
it may contain the commands your software or hardware 
wants you to use. 

To look at the contents of a CONFIG.SYS file, use the 
DOS Type command. If your setup is typical, you can type 
the following line from the DOS prompt: 

TYPE C:\CONFIG.SYS 

When you've typed this line, press the [Return)or!Enterl key. 
This Type command tells DOS to show you the contents 
of the CONFIG.SYS file located on the hard disk (drive 
c: ). DOS will either respond with the message "file 
not found" or will display the contents of the configura
tion file on your screen. 

If you do not have a hard disk, the configuration file will 
be on the floppy disk in drive A. In this case you should 
substitute A: for c: in the examples given here. So, to see 
the contents ofCONFIG.SYS on drive A, type this line: 

TYPE A:\CONFIG.SYS 

If you need to create or append to the configuration file, 
read The COPY Command section below. 

The COPY Command 
You can use the Copy command to put what you type at 
the console (keyboard) into a file. If your setup is typical, 
you can follow Steps l-4 to create a configuration file and 
put it into your root directory. 

Sample A - Create a. New CONFIG.SYS 

Step 1: At the DOS prompt type 

COPY CON: C:\CONFIG.SYS 

In this step you instruct DOS to copy what you type at the 
console (CON : is short for console) into a file called 
CONFIG.SYS. (If you already have a file called 
CONFIG.SYS on drive C, typing the above copy com
mand will overwrite the pre-existing configuration file.) 

Step 2: When you have typed the line from Step l, press 
the [Return] or(Enter] key. 

Step 3: Next type in whatever your configuration file 
needs, for example: 

FILES=20 



Step 4: When you are done typing, use the ffi key or 
hold down the {ctrl) key while you press the 
m key. 

Finally, press the [Return] or[ Enter] key. When you 
see the message 

1 File(s) Copied 

your mission is accomplished, except for proof
reading. If you don't see the message, carefully 
recreate the keystrokes in Step 4. 

If you already have a CONFIG.SYS file, you can append 
commands to it; here's how. 

Sample B -Append to an Existing CONFIG.STS 

Step 1: At the DOS prompt type 

COPY C:\CONFIG.SYS+CON: C:\CONFIG.SYS 

In step 1 you instruct DOS to copy the contents of the 
CONFIG.SYS file plus what you type at the console 
(CON:) into a file called CONFIG.SYS. 

Step 2: When you have typed the line from Step 1, press 
the (Return] or( Enter) key. 

Step 3: When you see the word CON on your screen, type 
in whatever your configuration file needs, for 
example: 

FILES=40 

Step 4: Follow step 4 from Sample A above. 

More on CON: 
Older versions ofDOS required a colon(:) after the device 
name CON, newer versions do not. To make our examples 
universally acceptable, we used the colon. Newer manuals, 
such as the PC-DOS 3.1, do not even show examples of 
the COPY CON statement with a colon after CON. If 
your PC/MS-DOS manual ignores the colon, you can too. 

Proofread 
To confirm that the contents of your new configuration file 
are correct, repeat the steps from The TYPE Command 
section above. 

Restart Your Machine 
Your machine won't recognize that there have been any 
changes in its configuration until you restart it. To do this 
hold down the (ctrl) and@!) keys, then press the {Del] key. 

The Electronic Whole Earth 

Mac Information Server Update 

~ 
We recently added a fifth volume to the 
Macintosh Information Server: the 
Whole_Catalog. This CD-ROM version of the 
Whole Earth Catalog contains over 400 mega

bytes of information. The catalog is educational and fun; it 
is a collection of reviews and sources of information 
ranging from ABC of Avalanche Safety to Zymurgy. 
However, since the catalog is not in the public domain, it 
is subject to the usual copying restrictions. 

The CD-ROM version of the Whole Earth Catalog in some 
respects is a showcase for this technology. The catalog's 
HyperCard front end makes it possible to traverse the huge 
volume of information in different ways because there are 
many links between pieces of information. 

In addition to text and pictures, the CD-ROM version of 
the Whole Earth Catalog contains digitized sounds that you 
play on your Mac. Alas, you must endure some pops and 
glitches when playing music and sounds from the Elec
tronic Whole Earth Catalog because the Mac Info Server 
sometimes cannot get the sound information across the 
network and into your Mac fast enough. We are exploring 
ways to minimize this problem. 

Perhaps this limitation is an incentive to buy your own 
CD-ROM disk and player. The Electronic Whole Earth 
Catalog from Broderbund Software currently costs 
$149.95 plus shipping. For more information about 
Broderbund products, call them at 800/521-6263. You 
can purchase Apple's CD-ROM player through the Micro 
Discount Program for $825. Apple's CD-ROM player 
connects to the Mac with SCSI cables which you must buy 
separately. 

Using the Electronic Whole Earth Catalog 
When you select the Whole_ Catalog volume you see the 
small icons shown in Figure 1. If you select and then open 
Whole Earth, as shown in Figure 1, you will then get the 
Table of Contents shown in Figure 2. You can use the 
Table of Contents in two ways: click on a picture for a 
complete index of that topic or click on the name to go 
directly into the domain. Be patient; it may take a while to 
start up the Whole Earth HyperCard stack if many others 
are accessing the Mac Information Server at the same time 
you are. 

First time users should click on the words Introduction & 
First Time Help and follow the hand to learn about navi
gating around this electronic catalog. Figure 3 shows a 
sample card from the Introduction section. 



Figure 1.: Whole_Catalog Volume 
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When you are finished using the Elec
tronic Whole Earth Catalog, you can 
exit by using the QJ4it command 
from the File menu or by using the 
shortcut Quit command: hold down 
the 00 key while you select the @) 
key. 

For our new readers: The Mac Infor
mation Server is a public-access file 
server; it contains system software 
updates, technical notes, some 
public-domain utilities, and other in
formation of interest to Macintosh 
owners. For a more detailed look at 
what is on the Mac Information 
Server and how to use the server, 
read our April 1989 article entitled 
Mac Information Sener Update. 

Using the 
Mac Information Server 
To access information on the server, 
you must meet two conditions: ( 1) 
your Macintosh must be connected 
to the AppleTalk Internet and (2) 
your Mac must have a copy of the 
AppleShare client software installed 
on the System disk used to start up 
the machine. 

The Macs at the Micro HelpLine and 
at public labs managed by Academic 
Computing Services and Systems 
(ACSS) are ready to access the Mac 
Information Server. (For more 

information about the public microcomputer labs, see our October 1988 
Public Microcomputer Labs and Special Senices newsletter article.) 

If the Mac on your desk is connected to a departmental network that is also 
part of the University's AppleTalk Internet, you can access the Mac Informa
tion Server from your office. (You may need to install the AppleShare client 
software; this software is included on the Utilities 1 disk of the System soft
ware, starting with Finder 6.1/System 6.0.) 

Figure 2: Catalog's Table of Contents 
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Figure 3: Sample of Introduction Card 
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Engineering Services Notes 
by Don Clark, ACSS Engineering Services 

Protecting Your Equipment 
Microcomputers are designed to be used in 
normal office environments and so are rela
tively safe from electrical static discharge 
(ESD) when operated normally. However, the 
circuits that make up your microcomputer are 
susceptible to ESD when you open the ma

chine to install something in it, for example a memory 
upgrade. 

Controlling Static Electricity 
A spark between the equipment's operator and a keyboard 
or monitor or printer can make the computer spontane
ously restart. If you experience this problem and suspect 
static electricity is the cause, take steps to control the static 
environment. Consider controlling the air in the room, 
the material in the room, building power wiring, and even 
the clothing you wear. There are hundreds of antistatic 
products on the market, such as coatings, cleaners, mats, 
and wrist straps, to control static electricity. 

The Air 
The drier the air the greater the static problem. You 
probably know from experience that static is at its worst 
during cold, dry Minnesota winters. Since the heating 
systems in many university buildings have no provision for 

Most vendor warranties are void if uncertified personnel 
handle their products. The majority ofESD damage 
occurs between the time of manufacture and the time it 
is installed in the computer device. Circuits are relatively 
safe once they are installed in the computer if the it humidifying the air, room humidifiers may be neces

sa~ in a ~oom with computer equipment and a high 
stanc enVIronment. 

chassis is properly grounded and shielded. ~ 

If you install or handle chips or circuit boards in .,ft 
your computer, you should follow these rules 
to avoid ESD damage: 
• Buy only from vendors who ship in shielded, puncture 

free, antistatic bags. 
• Keep circuits/ chips sealed in the bags until you are 

ready to install them. 
• Use wrist straps which are properly attached to a 

gounded antistatic mat. 

Static Electricity 
Most people know about static electricity through experi
ence, for example they receive a small electrical shock after 
walking across a carpet and touching a metal doornob. 

What does static electricity have to do with the reliability of 
your computer? Computers manufactured a few years ago 
were made of discreet components such as transistors, 
resistors, capacitors, etc., with relatively large dimensions. 
On early printed circuit boards, the chips were coarse by 
today's standards. These larger dimensions made the 
components relatively immune to electrical static discharge 
(ESD) damage. New technology has brought increased 
circuit density; this increased density allows ESD to occur 
at a much lower voltage. 

On the most sensitive new circuits, the internal geometry is 
so small that a spark of less than 50 volts can result in a 
discharge that will destroy or damage the circuit. (In order 
for you to feel a spark, the voltage must be at least 3000 
volts; this is sixty times greater than the 50 volts spark 
required to damage a circuit.) To further complicate the 
issue, a charged object brought in close contact with a chip 
can cause a discharge within the chip through induction. 
Thus, damage can occur without touching the chip or 
seeing or feeling a spark. 

Material in the Room 
Some common sources of static electricity are plastics, 
vinyl, painted/waxed/varnished surfaces, styrofoam, 
celluloid, and almost any product that starts with poly. 
Carpet is a notorious source of static unless it is treated 
with special chemicals. 

Clothing 
If you think we would go so far as to suggest what to wear, 
you're right. People in a normal work environment 
generate static electricity. Some of the highest sources of 
static are synthetic fibers such as orion, nylon, rayon, 
polyester, etc. (cotton is static neutral). A person wearing 
synthetic clothing in a dry room can generate a static 
charge as high as 50,000 volts with normal body move
ments. 

If you're installing anything inside your computer, take 
extra precautions. Here's a warning for installers that we 
recently received with a shipment of chips: the worst situ
ation is to wear leather shoes on almost 11-ny cR-rpet, especially 
wool, on a dry winter day ... finally, don't wear any nylon 
clothing, especially underwear. 

Building Wiring 
The main purpose of the ground wire on the power outlet 
is safety. If properly installed in the building, it also serves 
as a good conductor to minimize static buildup inside the 
computer. If you receive a real power jolt (as opposed to 
ESD) from a piece of equipment, call your plant/shop 
people immediately. The ground circuit may be defective. 

Conclusion 
Because the circuits that make up modern 
microcomputers are especially sensitive to ESD 
during installation, technicians who install 



Mac SE/30: floppy drive is 1.4MB Superdrive 
A13 M5390 1MB RAM, 1 floppy drive, $2785 

40MB internal hard disk 
(normal price is $3085; you save $300) 

Mac llcx: floppy drive is 1.4MB Superdrive 
A19 M5680 4MB RAM, 1 floppy drive, $4150 

80MB internal hard disk, and Mathematica; 
this configuration does not include a 
monitor or video card 
(normal price is $4485; you save $335) 

• Macintosh Changes 
We've two changes to report. Effective May 1st, the word 
processing software we are bundling with the Mac changes. 
Beginning May 1st you will be able to choose between 
MacWrite II or Microsoft Word; however, to substitute 
Word for MacWrite II, you must pay an additional $50. 
Please note: delivery of Microsoft Word is contingent upon 
Microsoft's ability to ship Word version 4.0 to us. As of 
press time, Microsoft still had not begun to ship version 
4.0. 

The second announcement is that Apple has lowered prices 
on the Mac Plus and the two Mac SEs listed below. 
(During the IT Tech Fair, the Mac Plus will be $949. 
After the fair the Mac Plus will be $999, as shown below.) 

Macintosh Configuration 
All Mac configurations include: Apple's standard keyboard 
(M0116), mouse, and the following software- HyperCard, 
MacPaint version 2.0, and MacWrite II. To substitute Apple's 
enhanced keyboard (M0115) for the standard keyboard, add 
$60 to the price of the Mac. To substitute Microsoft Word for 
MacWrite II, add $50 to the price of the Mac. 

No. Part Macintosh Description 

Mac Plus: disk drive is SOOK 
A2 M5880 1MB RAM, 1 floppy drive 

Mac SE: 
A3 M5910 
A4 M5252 

disk drive is SOOK 
1MB RAM, 2 floppy drives 
1MB RAM, 1 floppy drive, 
20MB hard disk 

• Ashton-Tate Orders 

Price 
Old New 

$1185 $999 

$2070 $1725 
$2425 $2150 

Q) 

Departmental users of dBASE and other Ashton-Tate 
products take notice. Since Ashton-Tate prefers to deal 
with one contact for the whole University, if a department 
orders a product or an upgrade directly from Ashton-Tate 
(for example through a quick order), Ashton-Tate re-mails 
the order to the Book Center. The Book Center then 
processes your order andre-mails it to Ashton-Tate. To 
speed up ordering, departments should place all their 
Ashton-Tate orders through the Book Center. 

e 
e 

• MacWrite Upgrades and Trade Ins 
If you are a registered owner ofClaris' MacWrite 5.0, you 
can upgrade to Claris' MacWrite II for $20. To do this 

' bring your original MacWrite 5.0 disk to the Electronics 
Desk. You may be able to get MacWrite II for $30 and a 
trade in on your current (non-MacWrite) word processing 
software. The trade-in program applies to WriteNow, 
WordPerfect, MindWrite, WordHandler, and Microsoft's 
Word, Write, and Works. To participate in the trade in, 
bring your original disks to the Electronics Desk. Whether 
you upgrade or trade-in, you must surrender your original 
disks to the Electronics Desk; they will forward your disks 
to Claris Corp. 

For more information on MacWrite II, read the review on 
page 98 of this newsletter. 

And Books, Too 
If you cannot find the computer books you want 
in the Bookstore's Reference section, tell us what 
books you want to buy. Send specific titles or 
areas of interest to: Maureen O'Brien, 160 
Williamson Hall, Minnesota Book Center, 231 

Pillsbury DriTJe SE, Minneapolis, MN 55455. 

Here's what is new in the Reference section: 
t/ AdTJanced Excel for the IBM PC, PS/2, and Compatibles 

by Ashley, a Wiley publication for $19.95. 
t/ Design and Implementation of the 4.3 BSD Unix 

Operating System by Leffler, an Addison Wesley 
publication for $38.50. 

t/ An Introduction to Berkley UNIX by Wang, a Wads
worth publication for $32.20. 

t/ Mastering dBASE IV Programming by Townsend, a 
Sybex publication for $22.95. 

G e 
G 
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I memory chips and circuit boards must take special anti
static precautions. Therefore, you should consider protect
ing your computer investment by having a qualified service 
technician upgrade or service your machines. 

In most cases a normally operated microcomputer is 
relatively immune to static problems, but if you have 
problems, you can take the steps mentioned above to 
minimize static electricity in your environment. 

Training Resources 

~ 
The Microcomputer Group owns training 
packages for many popular software programs. 
These training packages are available to Univer
sity of Minnesota departments and current 

employees and students. There is no fee for using these 
packages, and you may check them out for 48 hours. 
However, before you can check them out, you must sign a 
Usage Agreement and leave your University of Minnesota 
ID with us. We will return your ID when you return the 
training materials. 

To use these materials you must supply your own equip
ment, such as computer and cassette player. To reserve or 
check out materials, talk to Margaret Stefansky in room 
118 Shepherd Labs at phone 625-1300. 

Generally the PC/MS-DOS (IBM personal computer and 
compatible) disks are available on 5.25-inch 360Kand 3.5-
inch 720K disks; the Macintosh disks are 800K. The Mac 
packages listed below are marked with an tl; IBM packages 
are marked with a (•. 

New Material 
We recently added the following material to our training 
library. 

•!• PageMaker, How to Use audio training from Flip
Track. The lessons on the six audio tapes include: plan
ning publications, using PageMaker tools, using Windows, 
placing text and graphics, editing, formatting with style 
sheets, creating master pages and templates, special effects, 
working with fonts, kerning, layering graphics, and using 
print options. System Requirements: IBM-type personal 
computer with a hard drive, mouse, and your own copy of 
PageMaker and Windows. To complete the printing 
lessons you must have a laser printer. 

tl How to Operate the Macintosh II. This package 
contains four audio cassettes and a diskette for hands-on 
learning. Since the beginning sections COller basic use of the 

Macintosh, the material can be used by other Mac users. The 
package is designed for first-time Mac users and assumes 
no previous computer experience. 

Training Objectilles: Lessons cover starting the computer; 
opening, closing and resizing windows; duplicating disks 
and files; using the Font/DA Mover and using MultiFin
der; erasing disks and files; selecting commands from 
menus; using the mouse; and using HyperCard. System 
Requirements: Macintosh with one 800K internal disk 
drive and a hard disk drive; a printer is optional. 

Book Center Notes 
These offers are made to University departments, 
employees, and students; the regular rules of 
eligibility apply. If you have questions about 
availability, phone the Electronics Desk at 625-
6681. 

• May IT Tech Fair 
The IT Tech Fair is an annual event held during IT Week; 
it is a joint venture between the Plumb Bob Honorary 
Society and the University Bookstores. If you missed the 
whoopla surrounding the fair, check the Minnesota Daily 
and the 1989 IT Tech Fair folder on the information 
volume of the Mac Information Server for up-to-date 
developments on computer specials not mentioned here. 
The specials offered during IT Week run May 1st through 
May 19th. 

Here are the specials that had been finalized by the time we 
went to press. 

IT Tech Fair Specials: May 1-19 
Quantities are Limited 

All Mac configurations include: Apple's standard keyboard 
(M0116), mouse, and the following software- HyperCard, 
MacPaint version 2.0, and MacWrite II. To substitute Apple's 
enhanced keyboard (M0115) for the standard keyboard, add 
$60 to the price of the Mac. To substitute Microsoft Word for 
MacWrite II, add $50 to the price of the Mac. Please note: 
delivery of Microsoft Word is contingent upon Microsoft's ability 
to ship us Word version 4.0. 

As of press time, Microsoft still had not begun to ship Word 
version 4.0. 

No. Part 

Mac Plus: 
A2 M5880 

Macintosh Description 

disk drive is SOOK 
1MB RAM, 1 floppy drive, 

IT Fair Special 

$949 
and one 10-pack of Sony DSDD disks 
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• Call our Helpline 
626-4276 

(dial MA MICRO) 

• Visit our Helpline 
Room 125, Shepherd Labs 

East Bank Campus 

• We're Available 
9 am - 12 and 1:30- 4 pm 

Monday 
Tuesday 

Friday 

9 am through 4 pm 
Wednesday 

Thursday 

• Newsletter Staff 
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Academic Computing Services and Systems 
University of Minnesota 
Room 125, Shepherd Labs 
100 Union Street SE 
Minneapolis, MN 55455-0421 

• Newsletter Reprints 
If you want back issues of volumes 3 to the present 
issue, Kinkos will make them for you for a nominal fee. 
The master copies are downstairs at the Kinkos shop at 
306 15th Avenue SE. This shop is open Sunday
Saturday. The Information server, accessable from Mac
intoshes that are directly connect to the University's 
internet, has the twelve most recent issues of the 
newsletter. May 1989 {M/3.16} 
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